
 

GUIDA PER l'UTENTE 



Le informazioni contenute nel presente documento non hanno natura contrattuale e possono essere 

soggette a modifiche senza preavviso. 

  

Il software descritto nel presente manuale viene venduto con un contratto di licenza. Il software può 

essere utilizzato, copiato o riprodotto in base ai termini e alle condizioni del contratto. 

  

Il presente manuale non può essere copiato, riprodotto o trasmesso, in tutto o in parte, in nessuna forma, 

su nessun supporto e per nessuno scopo che si discosti dall'utilizzo da parte dell'acquirente, senza 

autorizzazione scritta di TEKLYNX Corporation SAS. 

  

  

  

  

©2021 TEKLYNX Corporation SAS, 

Tutti i diritti riversati. 
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Informazioni su questo manuale 

Convenzioni tipografiche 

Nel presente manuale vengono utilizzate diverse convenzioni per distinguere vari tipi di informazioni: 

• I termini dell'interfaccia, come i comandi, vengono visualizzati in grassetto. 

• I tasti sono scritti in maiuscolo. Ad esempio: "Premere il tasto MAIUSC". 

• Gli elenchi numerati indicano una procedura da seguire. 

• Quando accanto a un paragrafo compare la congiunzione -oppure-, significa che è possibile 

scegliere una procedura alternativa per svolgere un determinato compito. 

• Quando un comando di menu include dei sottomenu, il nome del menu seguito dal comando da 

selezionare compare in grassetto. Quindi, ''Scegliere File > Apri" significa selezionare il menu 

File, quindi il comando Apri. 

 

Informazioni sul prodotto 

Alcune funzionalità descritte nel manuale potrebbero non essere disponibili per il prodotto. 

Fare riferimento alle specifiche tecniche fornite con il prodotto per un elenco completo delle funzionalità 

specifiche del software. 
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Introduzione 

Benvenuto! 

Il pacchetto software per l'identificazione automatica che ha appena acquistato è leader sul mercato 

mondiale. 

Presentazione 

Questo software per la creazione delle etichette consente di creare e modificare rapidamente etichette 

complesse, integrando tutti i dati elettronici aziendali, garantendo la totale sicurezza di tutti i sistemi. 

L'applicazione soddisfa tutti i requisiti di identificazione automatica e si integra perfettamente nel processo 

di produzione. 

Nel mercato attuale è la soluzione più facile e intuitiva per tutte le aziende che operano nell'inserimento, 

nella raccolta e nella modifica in tempo reale dei complessi dati dei codici a barre. 

Descrizione del prodotto 

Il prodotto include i seguenti componenti: 

• DVD di installazione. 

• Documentazione completa in formato elettronico. 

• Contratto di licenza e scheda di registrazione. 

• Una chiave di protezione elettronica (chiave software) o fisica (chiave hardware). 

Requisiti di sistema 

I requisiti software e hardware per eseguire l'applicazione sono simili a quelli necessari per la maggior 

parte delle applicazioni Windows™: 

• OPERATING SYSTEM 

Windows®10 x86/x64  

Windows®8.1 x86/x64 

Windows®8 x86/x64 

Windows® Server 2019  
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Windows® Server 2016 

Windows® Server 2012 R2 

Windows® Server 2012 

• PIATTAFORME VIRTUALI 

Necessitano una licenza VM 

• MEMORIA 

RAM da 2GB o più RAM (raccomandati 4GB - in base al sistema operativo e all'utilizzo). 

• Spazio sull'hard disk 

Unità disco con almeno 1.5 GB di spazio libero (a seconda delle opzioni di installazione). 

• DISPLAY 

Scheda video: adattatore display Windows con risoluzione 1024x768 con capacità True Color e 

DirectX® 9 (raccomandata scheda conforme a DirectX 11). 

• Software compatibili 

Microsoft .NET Framework 4.6.1 (fornito con l’installazione) 

Il lettore dei file PDF (Adobe Acrobat Reader) è disponibile con l’installazione 

• Ulteriori requisiti 

Diritti di accesso al computer come amministratore durante l'installazione. 

Almeno un driver per la stampante installato sul computer 

Per le licenze Online è richiesto quanto segue:                

           - Accesso Internet al server delle licenze 

           - Le porte 80 e 443 devono essere aperte (proxy, firewall) 

           - L’autenticazione Proxy non è direttamente supportata per le licenze Online 

Nota: Per scongiurare qualsiasi problema di compatibilità, rimuovere tutte le versioni precedenti di questo 

software eventualmente installate nel sistema. 

Nota: Il file Release_Notes_En.pdf contiene le informazioni più aggiornate sul software. Tali informazioni 

sostituiscono quelle contenute nel presente manuale. 
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Installazione 

Nota: Prima di installare il software, salvare il proprio lavoro e chiudere tutti i programmi. 

Prima di eseguire il programma di installazione, verificare la configurazione del proprio PC. 

1. Posizionare il DVD di installazione nel drive appropriato. Viene visualizzata la finestra di 

installazione. 

Se il DVD non parte automaticamente : Selezionare Start > Esegui , quindi digitare la lettera del 

drive del DVD seguita da index.hta (ad esempio: D:\index.hta). 

2. Selezionare il prodotto da installare, fare clic sul pulsante Install e seguire le istruzioni che 

vengono visualizzate sullo schermo. 

Installazione del software 

Selezionare la configurazione del programma che si desidera installare, quindi fare clic su Next. 

 

Prima di eseguire il processo di installazione, assicurarsi di avere i diritti di amministratore locale.  
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Protezione della licenza 

Il software può essere protetto grazie a una chiave software (un codice di attivazione) o una chiave fisica 

(una chiave hardware). 

• La chiave hardware è un piccolo dispositivo elettronico che viene inserito nella porta parallela o 

USB del PC prima di avviare il software. Senza la chiave hardware di protezione del software, il 

programma viene eseguito in modalità "valutazione". In questa modalità non è possibile salvare e 

stampare le etichette. 

• La chiave software è un codice che viene richiesto dalla procedura guidata di attivazione quando 

si avvia il software per la prima volta o finché si esegue una versione di prova. Se si utilizza una 

chiave software di prova, si hanno a disposizione 100 esecuzioni o 30 giorni per provare il 

prodotto con tutte le funzionalità disponibili. 

Nota: Quando viene avviata l’applicazione, viene visualizzata una finestra di dialogo che fornisce le 

istruzioni necessarie nel caso in cui la chiave di protezione del software non corrisponda alla versione del 

prodotto di cui si è in possesso. 

È necessario innanzitutto eseguire l’installazione del software di etichettatura e quindi attivare la chiave di 

protezione o collegarla al computer. 

Nota: Se è stata acquistata una licenza di Rete, installare prima la Gestione licenze di rete (Network 
License Manager) per installare il server delle licenze. Installare il prodotto su ciascuna postazione. Per 

collegare le postazioni alla rete occorre avviare il software in modalità di prova e selezionare 

Amministrazione di Rete. 

  

Protezione con chiave hardware 

Se si è acquistato il software con una chiave hardware, è possibile scegliere tra una chiave per porta USB 
o parallela. 

Collegamento della chiave parallela: 
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Se sulla stessa porta parallela viene utilizzata una stampante, è sufficiente inserirla nella chiave di 

protezione del software. In tal caso può essere necessario accendere la stampante per consentire il 

riconoscimento della chiave di protezione del software. 

Collegamento della chiave USB: 

 

Se si utilizza una chiave USB e si dispone di varie porte USB, la chiave può essere inserita in una 

qualunque delle porte. Se non si ha a disposizione una porta USB, è possibile utilizzare un hub di 

espansione USB. I dispositivi USB sono hot-swap, quindi possono essere inseriti e disinseriti dal bus in 

qualunque momento, senza la necessità di riavviare il PC. 

Nota: I driver possono essere installati mentre l’applicazione è in esecuzione. Tuttavia, perché le 
modifiche abbiano effetto sarà necessario riavviare il software per l'etichettatura. 

Installazione manuale del driver della chiave 

Se si desidera installare manualmente il driver della chiave, seguire questa procedura: 

1. Selezionare Start, quindi Esegui. 
2. Specificare il percorso: 

 

Inserire [Cartella di installazione del prodotto]\Tools\Dongle\ quindi digitare il seguente 

comando: \HaspDinst.exe -i 

Nota: Si consiglia di chiudere il software di etichettatura e altre eventuali applicazioni prima di installare il 

driver. 

  

Protezione con chiave software 

Dopo aver installato il software per etichettatura, verrà avviata l'attivazione guidata che fornisce 

indicazioni passo passo per attivare la protezione tramite chiave software. 
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Attivazione della protezione 

Nell'attivazione guidata, selezionare Attiva. Esistono quattro possibili metodi di attivazione: Attivazione 
online, tramite chiavetta USB, tramite smartphone e tramite il sito Web. 

Nota: Se il computer in cui è installato il software dispone di una connessione a Internet, viene 

selezionata automaticamente l'attivazione online. 

• Attiva online 

Alcune reti aziendali sono protette da un server proxy. In tal caso, è necessario effettuare un ulteriore 

passaggio che consente di immettere l’indirizzo IP e di connettersi a Internet 

1. Immettere il Numero di serie e la password forniti con il prodotto e fare clic su Avanti. 
2. Immettere le informazioni nel modulo Registrazione utente. Fare clic su Avanti. 

3. Fare clic su Fine. 

Nota: Per le licenze Online è richiesto quanto segue:                

           - Accesso Internet al server delle licenze 

           - Le porte 80 e 443 devono essere aperte (proxy, firewall) 

           - L’autenticazione Proxy non è direttamente supportata per le licenze Online 

Nota: Se il computer in cui è installato il software non dispone di una connessione Internet ma se si ha 

accesso a un altro computer con connessione a Internet, è possibile eseguire l'attivazione tramite 
chiavetta USB. 

• Tramite chiavetta USB 

1. Immettere il numero di serie e la password forniti con il prodotto e fare clic su Avanti. 
2. Selezionare Con una chiavetta USB. 

3. Selezionare il supporto da utilizzare per l’attivazione (chiavetta USB o disco rigido esterno oppure 

unità di rete) e fare clic su Avanti. I file per l’attivazione verranno copiati sul supporto selezionato. 

4. Solo per dispositivi USB: scollegare il supporto removibile e collegarlo al computer dotato di 

connessione a Internet. 

5. Nel computer connesso a Internet, fare doppio clic su USBWizard.exe (situato nella directory 

radice del supporto). Verrà avviata l'Attivazione guidata. 

6. Selezionare le licenze da attivare e fare clic su Avanti 
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7. Immettere o modificare le informazioni nel modulo Registrazione utente. Fare clic su Avanti. 

Se invece è già stato registrato, procedere alla fase 8. Apparirà un messaggio che comunica che i 

dati di attivazione per le licenze selezionate sono stati recuperati correttamente. 

8. Solo per dispositivi USB: scollegare il supporto removibile dal computer e ricollegarlo al 

computer in cui è installato il software. 

9. Nel computer in cui è installato il software, fare di nuovo doppio clic su USBWizard.exe (ubicato 

nella directory radice del supporto). L'Attivazione guidata visualizzerà la licenza attivabile sul 

computer sul quale è installato il software. 

10. Fare clic su Avanti. 
11. Fare clic su Fine. 

Nota: Se non si ha accesso a un computer dotato di connessione a Internet, è possibile attivare ilprodotto 

tramite smartphone. 

• Tramite smartphone 
Per leggere il codice a barre che consente di attivare il software tramite smartphone è necessaria 

un'applicazione di scansione dei codici a barre, da scaricare dal negozio / punto vendita dell'applicazione. 

Questa modalità di attivazione sfrutta la connessione a Internet dello smartphone. 

1. Immettere il Numero di serie e la password forniti con il software e fare clic su Avanti. 
2. Selezionare Con uno smartphone. 

3. Immettere le informazioni nel modulo Registrazione utente. Fare clic su Avanti. 
4. Verrà visualizzato un codice a barre. Spostare il cursore sul codice a barre per ingrandirlo. 

5. Aprire l'applicazione di scansione dei codici a barre sullo smartphone. 

6. Scansionare il codice a barre con lo smartphone. 

7. Fare clic su Continua o aprire il browser sul telefono. 

8. Verrà visualizzato il sito Web di attivazione del software. Qui è possibile registrarsi e attivare il 

software. Compilare tutti i campi. 

9. Fare clic su Inoltra. 

Il Codice di convalida e il Codice d'installazione vengono visualizzati in fondo alla pagina Web 

di attivazione del software. Se necessario, scorrere verso il basso. 

10. Inserire il Codice di convalida e il Codice d'installazione in maiuscolo durante la procedura 

guidata. 

11. Fare clic su Avanti. 
12. Fare clic su Fine. 

• Tramite il sito Web 
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1. Selezionare Con il nostro sito Web. 
2. Il collegamento fornito in questa schermata (http://www.teklynx.eu/nsp/) è raggiungibile da un altro 

computer dotato di accesso a Internet. Per completare l'attivazione occorre utilizzare un computer 

dotato di connessione a Internet per collegarsi al sito Web per l'attivazione. Per utilizzare questo 

servizio verranno richiesti numero di serie e password (forniti con il prodotto) e il Codice utente 

(visualizzato nella procedura guidata). 

3. Immettere i dati dell'utente della licenza nel modulo Registrazione utente visualizzato nel nostro 

sito Web. Fare clic su Avanti. 
4. Fare clic su Inoltra. 

5. Il Codice di convalida e il Codice d'installazione verranno visualizzati sul nostro sito Web. 

Immetterli nell'Attivazione guidata in maiuscolo e fare clic su Avanti. 
6. Fare clic su Fine. 

Avvio del programma 

1. Selezionare Start > Programmi. 
2. Selezionare il nome che è stato dato al gruppo di programmi durante l'installazione (come 

impostazione predefinita, è il nome dell'applicazione). Viene visualizzata la finestra principale. 

Messaggi di errori all'avvio del software 

Se all’avvio del software viene visualizzato un messaggio di errore, verificare quanto segue: 

• I diritti di amministrazione. Per il corretto funzionamento della chiave, è necessario disporre dei 

diritti di amministratore sul PC. Se non si dispone di tali diritti, viene visualizzato un messaggio di 

errore all’avvio del software. In questo caso i driver devono essere installati manualmente. 
• Installazione dei driver. Se si incontrano problemi durante l’installazione o se viene visualizzato 

un messaggio di errore all’avvio del software, è necessario installare manualmente i driver. 
• La chiave: Verificare che la chiave connessa funzioni con il software per l'etichettatura. 

• Aggiornamento del driver: Il driver potrebbe non essere aggiornato. Per aggiornarlo, è 

necessario scaricarlo dal sito Web all'indirizzo http://www.aladdin.com/support/hasp/enduser.aspx 
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Scoperta dell’interfaccia 

Descrizione della finestra principale 

Questa sezione comprende una panoramica generale degli elementi della finestra principale nell'ordine in 

cui vengono visualizzati all'inizio di una sessione di lavoro. 

La barra dei menu 

La barra dei menu contiene le seguenti opzioni: File, Modifica, Visualizza, Oggetto, Origine de dati, 
Strumenti, Finestra e Guida. 

Per aprire un menu 

1. Selezionatelo con il pulsante sinistro del mouse. 

2. Quindi scegliete il comando desiderato. 

Nota : Per accedere a un comando tramite la tastiera, utilizzare i tasti di scelta rapida. Premere ALT 

seguito dalla lettera sottolineata nel nome del menu o del comando. 

Lo spazio di lavoro 

Lo spazio di lavoro è la parte centrale della finestra, posta fra i righelli e le barre di scorrimento. Contiene 

un riquadro che fissa i limiti del documento e include gli oggetti da stampare nonché un'area non 

stampabile per inserire annotazioni e oggetti che non si desidera stampare. 
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Il documento 

Quando viene aperta una nuova sessione, il programma visualizza un riquadro nella parte in alto a sinistra 

della finestra. Questo riquadro rappresenta i limiti del documento da stampare. 

Posizionare all'interno del riquadro gli oggetti necessari a creare il documento. 

La barra di stato 

Posizionata nella parte inferiore della finestra, la barra di stato visualizza il nome della stampante 

selezionata, la porta di comunicazione cui è connessa, le coordinate x e y del puntatore del mouse e le 

dimensioni cx e cy dell'oggetto selezionato. 

Posizionata nella parte inferiore della finestra, la barra di stato mostra il nome della stampante 

selezionata, la porta a cui è connessa, le coordinate x e y del puntatore del mouse, le dimensioni cx e cy 

dell'oggetto selezionato e il numero dei giorni di validità rimanenti della licenza. 

 
  
Le diverse Sezioni sulla barra di stato sono cliccabili per richiamare le finestre di dialogo appropriate: 

• Se un documento è aperto, fare doppio clic sull'area del nome della Stampante per mostrare la 
finestra di dialogo delle Impostazioni della stampante. 

• Se un documento è aperto, fare doppio clic sull'area del nome della Porta per mostrare la finestra 
di dialogo Cambia porta della stampante. Questa azione non è disponibile per il driver delle 
stampanti di Windows. 

• Se un oggetto è selezionato e non bloccato, fare doppio clic sull'area dell'oggetto per mostrare le 
Proprietà dell'oggetto selezionato. Se è selezionato più di un oggetto, sono aperte le Proprietà 
dell'ultimo oggetto selezionato. 

• Fare doppio clic sull'area Giorni rimasti per mostrare la finestra di dialogo Informazioni.  

Le barre degli strumenti 

Questi strumenti consentono di eseguire attività di routine più rapidamente rispetto all'uso del mouse. 

 

Selezione degli strumenti: Fate clic sul pulsante che corrisponde allo strumento. 

La barra del titolo 

La barra del titolo visualizza il nome del software e del documento corrente o "documenton. " nel caso in 

cui sia stato creato un nuovo documento. Consente di spostare la finestra dello spazio di lavoro con il 

mouse. 
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La barra degli strumenti di formattazione del testo 

Questi strumenti consentono di modificare la formattazione di testo e/o di un paragrafo, ad esempio 

modificare il font, la dimensione dei caratteri, le opzioni di stile, l'allineamento e così via. 

 

Per modificare la formattazione: 

1. Selezionare un oggetto nel documento. 

2. Fare clic sulle opzioni desiderate. 

Nota: Tutte queste opzioni sono accessibili anche dalla finestra di dialogo Testo tramite il comando 

Oggetto > Testo. 

La barra degli strumenti Oggetto 

La barra degli strumenti Oggetto visualizza il nome dell'oggetto selezionato e consente di accedere alle 

proprietà di tale oggetto. 

  

La barra degli strumenti Visualizza 

La barra degli strumenti Visualizza offre diverse opzioni di visualizzazione. 

Per modificare la modalità di visualizzazione fare clic sulla modalità desiderata: 

Pulsante Nome dello strumento Funzione 

  
Nome Visualizza i nomi delle variabili. 

  
Dimensione Visualizza la dimensione massima delle variabili. 

  
Contents Visualizza i valori delle variabili. 

  Modulo Visualizza il modulo. 

  
Visualizza Visualizza le viste Oggetti e Origini dati. 

  
Zoom Consente di aumentare o diminuire il dettaglio degli 

oggetti 
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Nota: Tutte queste opzioni sono accessibili anche dal menu Visualizza. 

  

La barra degli strumenti di creazione 

La barra degli strumenti di creazione include diversi pulsanti che rappresentano ognuno uno strumento 

per creare e manipolare oggetti. 

Pulsante Nome dello strumento Funzione 

 

Selection tool Consente di selezionare e manipolare tutti i tipi di oggetto. 

 

Testo Consente di creare testo fisso e variabile. 

 

Codici a barre Consente di creare codici a barre fissi e variabili. 

 

Immagini Consente di inserire immagini. 

 

Linee Consente di disegnare linee orizzontali o verticali. 

 

Rettangoli Consente di disegnare rettangoli o quadrati. 

 

Forme circolari Consente di disegnare forme circolari. 

 

Figure libere Consente di disegnare figure libere costituite da linee. 

 

Linee diagonal Consente di disegnare linee diagonali. 

 

Rettangoli con angoli arrotondati Consente di disegnare rettangoli con angoli arrotondati. 

 

Figure già pronte Consente di importare nel documento figure già pronte. 

 

Plug-ins Consente di creare campi TextArt / Campo di testo RTF 

Viste Origini dati e Oggetti   

La vista Origini dati visualizza le origini dati e il numero di variabili associato. È possibile inserire gli 

oggetti variabile semplicemente trascinandoli nel documento. È possibile inoltre aggiungere, eliminare, 

duplicare e modificare le proprietà delle variabili utilizzando il menu Contesto.  

La vista Oggetti mostra il numero di oggetti creati per tipo e le relative proprietà come la posizione, 

l'altezza e la larghezza. Da questa scheda, è possibile creare un oggetto, selezionare un oggetto e 

cambiarne la posizione. 
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I tasti con la freccia rivolta verso l'alto e verso il basso consentono di muoversi in su e in giù nella struttura 

ad albero. I simboli + e - consentono di espandere o contrarre l'elenco e di visualizzare l'elenco delle 

variabili associate a ogni origine dati o gli oggetti disponibili per ogni categoria. 

Informazioni sulle origini dati 

Una origine dati contiene una lista di variabili costituita da dati con la stessa origine. 

Quando si seleziona una origine dati, si indica il tipo e la posizione del dato richiesto. I dati possono 

avere origine interna (Data, Contatore) o esterna all'applicaizone (Database, inserimento dati 

diretto tramite il Modulo). 

Le varie origini dati disponibili nella vista Data Sources sono le seguenti: Database, Data, Modulo, 

Formula, Ricerca in tabella, Contatore e Libera. 

Righelli 

I righelli vengono utilizzati per visualizzare la posizione del mouse e per posizionare accuratamente i vari 

oggetti nel documento. Possono essere impostati in pollici o millimetri utilizzando il comando Strumenti > 
Opzioni. 

I righelli consentono di individuare la posizione del puntatore del mouse e posizionare con assoluta 

precisione gli oggetti da includere nel documento. Possono essere configurati in pollici o millimetri 

utilizzando il comando Strumenti > Opzioni > Visualizza. 

• Facendo doppio clic sulla parte sinistra del righello orizzontale si riduce la percentuale di 

visualizzazione. 

• Facendo doppio clic sulla parte destra del righello orizzontale si aumenta la percentuale di 

visualizzazione. 

• È possibile visualizzare il menu di scelta rapida Zoom facendo clic con il pulsante destro del 

mouse sul righello verticale.  
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Pulsante di rotazione 

Se si fa clic su   nella parte in alto a sinistra del documento è possibile ruotare il documento stesso di 

90°, 180°, 270° o 360° sullo schermo. La rotazione a schermo è una funzionalità esclusivamente di 

visualizzazione, non ha alcun effetto sulla stampa. 

Per ruotare un documento: 

• Fare clic sul pulsante di rotazione con il mouse e ruotare il documento di 90° verso sinistra. 

• Fare clic sul pulsante di rotazione con il pulsante destro del mouse e ruotare il documento di 90° 

verso destra. 

Nota: Lo stesso effetto di rotazione del documento può essere ottenuto utilizzando il comando View > 

Orientation o facendo clic sul righello verticale con il pulsante destro del mouse per visualizzare il menu di 

scelta rapida. 
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Configurazione dell’ambiente di lavoro 

Scelta della stampante 

Prima di iniziare a creare un documento, è necessario impostare l'ambiente di lavoro. 

Il primo passo consiste nel selezionare la stampante con cui si desidera stampare le etichette. Le 

stampanti non hanno tutte le stesse caratteristiche, di conseguenza sono disponibili opzioni diverse a 

seconda del modello di stampante scelto. 

La seconda fase consiste nell'impostazione delle opzioni dell'ambiente di lavoro, ad esempio la lingua 

dell'interfaccia, l'unità di misura ecc. Tutte le opzioni disponibili verranno esaminate più avanti nel capitolo. 

La fase finale consiste nell'impostazione delle pagine dei documenti, ad esempio nella definizione delle 

dimensioni del documento, dell'orientamento, dei margini ecc. 

Il software di creazione delle etichette consente di stampare con un'ampia gamma di stampanti i cui driver 

sono forniti con il software. È inoltre possibile stampare con una stampante Windows installata in locale 

sulla macchina o sulla rete aziendale. 

È necessario selezionare la stampante prima di iniziare la creazione del documento in quanto la scelta 

della stampante determina la configurazione delle opzioni di pagina, l'uso di diversi font di carattere e così 

via. 

 

Selezione di una stampante 

È possibile accedere alla finestra di dialogo Printer selection tramite: 

Il comando File > Seleziona stampante 
-oppure- 

Facendo clic sul pulsante   
-oppure-- 

pressione del tasto F5. 

È possibile accedervi anche facendo clic sul pulsante Stampante nella finestra di dialogo Stampa (F6). 
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È necessario selezionare una stampante prima di creare il documento. La scelta della stampante influisce 

sulle opzioni di impostazione, sull'uso dei vari font ecc. 

Stampanti di Windows e stampanti native 

Come abbiamo già visto, il software di creazione delle etichette è in grado di stampare su un'ampia 

gamma di stampanti di Windows e native, sia dirette che a trasferimento termico. 

Il termine stampante di Windows fa riferimento a qualsiasi stampante installata sul sistema operativo, 

generalmente si tratta di stampanti per ufficio, laser e così via. I lavori di stampa vengono inviati allo 

spooler (coda processi). 

I driver per le stampanti native e a trasferimento termico vengono forniti con il software di creazione delle 

etichette. La stampa su queste stampanti viene gestita direttamente dal software. 

Per selezionare una stampante 

1. Scegliere File > Seleziona stampante. 

È anche possibile fare clic sul pulsante   o premere F5. 

2. Selezionare una stampante dall'elenco. 
3. Fare clic su OK. 

Nota : I driver forniti dall'applicazione sono caratterizzati da un'icona  . 

  

Aggiunta di una stampante 

È possibile accedere alla finestra di dialogo Installazione stampante tramite il comando File > Seleziona 
stampante, e facendo clic su Aggiungi. 

Questa finestra di dialogo consente di aggiungere i driver della stampante forniti con il software. 

Nota: Per aggiungere una stampante di Windows, è necessario utilizzare il Pannello di controllo. 

Per aggiungere una stampante: 
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1. Fare clic su File > Seleziona stampante. 

È anche possibile fare clic sul pulsante    o premere F5. 

2. Fare clic su Aggiungi. 
3. Selezionare un tipo e quindi un modello di stampante dall'elenco Modello. 

4. Selezionare la porta di comunicazione (seriale, parallela o file), quindi fare clic su OK. 

Nota: Fare clic sul simbolo (+) accanto al tipo di stampante per visualizzarne i vari modelli. 

Le porte di comunicazione 

Nome porta Funzione 

COMx Indica le porte di comunicazione seriali. Selezionare il numero della porta seriale 

cui la stampante è connessa. 

LPTx Indica le porte di comunicazione parallele. Selezionare il numero della porta 

parallela cui la stampante è connessa. 

File Selezionare File se si desidera stampare su file. 

Esempio: Aggiunta di una Zebra 140 su LPT1 

1. Scegliere File > Seleziona stampante. 

2. Fare clic su Aggiungi. 
3. Dall'elenco Modello selezionare il gruppo Zebra, quindi b. 

4. Selezionare la porta di comunicazione LPT1, deselezionare la casella Direct access, quindi fare 
clic su OK. 

 

Personalizzazione dell'ambiente di lavoro 

Il software offre numerose opzioni di personalizzazione dell'ambiente di lavoro. 

Tali opzioni includono la scelta della lingua dell'interfaccia, dell'unità di misura, delle cartelle di lavoro e del 

tasso di conversione delle valute. 
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Modifica della lingua dell'interfaccia 

L'interfaccia utente è disponibile in diverse lingue e può essere modificata con facilità. 

1. Scegliere Strumenti > Opzioni. 
2. Fare clic sulla scheda  Visualizza. 

3. Selezionare la lingua. 
4. Fare clic su OK. 

Nota : Quando si fa clic su OK, tutti i menu, i comandi e i messaggi a video verranno visualizzati nella 

lingua selezionata (fanno eccezione la guida in linea e le finestre di dialogo di Windows, come Apri e 

Salva con nome).  

 

Modifica delle opzioni di visualizzazione e dell'ambiente di lavoro 

È possibile modificare la lingua dell'interfaccia, l'unità di misura. Per modificare queste opzioni, utilizzare 

la scheda Visualizza. 

Per accedere alla scheda Visualizza, selezionare Strumenti > Opzioni. 

 

Scelta dell'unità di misura 

L'unità di misura può essere millimetri o pollici. L'impostazione dell'unità di misura modifica i righelli. 

1. Scegliere Strumenti > Opzioni. 
2. Fare clic sulla scheda Visualizza. 

3. Selezionare l'unità di misura desiderata. 

4. Fare clic su OK. 
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Modifica della scala delle griglie 

La scala delle griglie, utilizzata per allineare gli oggetti, può essere modificata o disabilitata.   

1. Scegliere Strumenti > Opzioni. 
2. Fare clic sulla scheda Griglia. 

-oppure- 

Fare doppio clic sul righello verticale per accedere direttamente alla scheda Griglia. 

3. Selezionare la scala desiderata. 

4. Fare clic sull'opzione Visualizza. 

5. Fare clic su OK. 

Nota : L'unità di misura utilizzata per la scala delle griglie viene definita nella scheda Visualizza. 

 

Definizione del tasso di conversione 

Il tasso di conversione definito nella finestra viene utilizzato nelle formule eurotocurrency (daeuroavaluta) 

e currencytoeuro (davalutaaeuro). 

1. Scegliere Strumenti > Opzioni. 
2. Fare clic sulla scheda Altre. 

3. Immettere il tasso di conversione nella finestra. 

Note: Il tasso di conversione predefinito è tra il franco francese e l'euro. 

 

Definizione della cartella di lavoro 

La prima volta in cui vengono aperte le finestre di dialogo Apri e Salva con nome dopo aver avviato il 

software, la cartella Documenti viene selezionata come cartella di lavoro predefinita. 

1. Scegliere Strumenti > Opzioni quindi la scheda Cartelle predefinite. 
2. Fare clic sulla colonna del Percorso per modificare la cartella di lavoro predefinita. 

-oppure- 



Configurazione dell’ambiente di lavoro 

25 

Fare clic sul pulsante  e selezionare la nuova cartella di lavoro predefinita. Modificare il 

percorso nella colonna Percorso 

3. Fare clic su OK. 

   

Impostazione delle pagine: Formattazione di un documento 

Formattazione di un documento 

I modelli dei documenti vengono creati e modificati nella finestra di dialogo Imposta pagina 

Formattare un documento significa impostare le dimensioni della pagina, l'orientamento, il numero di 

etichette per riga e per colonna, la dimensione del documento, i margini e la distanza fra le etichette. È 

possibile creare i propri modelli di documento e salvarli per un utilizzo futuro. 

Nota: Prima di creare un modello di documenti, è necessario scegliere il modello di stampante che si 

utilizzerà per produrre i documenti. Scegliere File > Seleziona stampante. 

Definire il formato della pagina nella finestra di dialogo Imposta pagina. Vengono così aggiornate le 

impostazioni della stampante. Il software non utilizza le impostazioni della pagina definite nella finestra di 

dialogo Configura la stampante. 

1. Scegliere File > Imposta pagina. 

-oppure- 

Fare clic sul pulsante . 

- oppure- 

Clic destro nel documento > Clic su Imposta pagina 

-oppure- 

Fare doppio clic in un punto qualsiasi del documento 

1. Fare clic sulla scheda Etichetta e immettere la dimensione e il numero delle etichette. 

2. Fare clic sulla scheda Pagina e selezionare la dimensione e l'orientamento della pagina. 

3. Digitare i valori desiderati nella scheda Margini. La scheda Modello consente di salvare i modelli 

personalizzati. 

4. Fare clic su OK. 
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Nota : Quando i parametri immessi sono incompatibili con la dimensione del modello, viene visualizzato 

un messaggio di errore. 

Esempio: Creazione e definizione dell'impostazione della pagina per un modello personalizzato 

1. Creare un nuovo documento. 

2. Selezionare la stampante di Windows generica. 

3. Scegliere File > Imposta pagina. 

  - oppure - 

  Fare clic sul pulsante . 

   - oppure - 

Clic destro nel documento > Clic su Imposta pagina 

-oppure- 

Fare doppio clic in un punto qualsiasi del documento 

4. Fare clic sulla scheda Etichetta e immettere i seguenti valori: 

    Larghezza e Altezza: 30/30 

    Numero per etichette: 

       Per riga: 2 

       Per colonna: 3 

    Raggio angolo 0 

5. Fare clic sulla scheda Pagina e immettere i seguenti valori: 

  Page sizing: Dimensionamento automatico 

6. Fare clic sulla scheda Margini e immettere i seguenti valori: 

    Margini: 
       A sinistra: 10 

       In alto: 10 

    Spazio: 

       Tra colonna: 5 

       Tra righe: 5 

7. Fare clic sulla scheda Modello e immettere i seguenti valori: 

    Tipo: Family 

    Nome: Layout1 

8. Fare clic su OK quindi salvare l'etichetta come InstallDir\Samples\Forms\Tutorial\TEST1. 
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Creazione di una custodia per CD: impostazione della pagina e creazione di un modello 
personalizzato 

1. Creare un nuovo documento e denominarlo FRONT. 

2. Selezionare la stampante. 

3. Scegliere Strumenti > Opzioni, fare clic sulla scheda Visualizza e selezionare Millimetri come 

unità di misura. Fare clic su OK. 

4. Scegliere File > Imposta pagina 

- oppure - 

Fare clic sul pulsante  . 

   - oppure - 

Clic destro nel documento > Clic su Imposta pagina 

-oppure- 

Fare doppio clic in un punto qualsiasi del documento 

5. Fare clic sulla scheda Etichetta e immettere i seguenti valori: 

• Larghezza e Altezza: 120, 

• Raggio angolo: 100, 

• Numero per etichette: 

• Per riga: 1, 

• Per colonna: 2. 

6. Fare clic sulla scheda Pagina e selezionare i seguenti valori: 

• Dimensione pagina: A4, 

• Orizzontale. 

7. Fare clic sulla scheda Margini e immettere i seguenti valori: 

• Margini: 

• A sinistra: 40, 

• In alto: 10, 

• Spazzio: 

• Tra righe: 15. 

8. Fare clic sulla scheda Modello e immettere i seguenti valori: 

• Type: Jaquette, 

• Name: CDx2. 
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9. Fare clic su OK. 

Note: La stampante utilizzata in questo esempio è una stampante di Windows™. Se si desidera utilizzare 

una stampante termica, è possibile che vengano visualizzati messaggi di errore durante l'impostazione 

della pagina. Sarà quindi necessario modificare i valori suggeriti nell'esempio poiché, come abbiamo già 

visto, la scelta della stampante influisce su alcune impostazioni. 

 

Eliminazione di un modello personalizzato 

Se un modello creato non è più necessario, è possibile eliminarlo. 

Per eliminare un modello personalizzato:  

1. Scegliere File > Imposta pagina. 

-oppure- 

Fare clic sul pulsante . 

-oppure- 

Clic destro nel documento > Clic su Imposta pagina 

-oppure- 

Fare doppio clic in un punto qualsiasi del documento 

2. Nella scheda Modello, selezionare il modello dagli elenchi Tipo e Nome. 

3. Fare clic sul pulsante Rimuovi. 
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Composizione di un documento con oggetti fissi 

Creazione e manipolazione di oggetti fissi 

La creazione di oggetti fissi implica l'inserimento di oggetti quali testo, codici a barre, immagini, righe, 

rettangoli e cerchi nel proprio commento. 

Creazione di oggetti 

Si può creare in modo rapido e veloce un oggetto nel proprio documento (codice a barre, immagine, testo, 

disegno, ecc.) usando: 

• La barra degli strumenti Creazione  
- OPPURE - 

• Il menu Oggetto.  

- OPPURE - 

• La vista Oggetti usando il menu di scelta rapida su ciascun tipo di oggetto each object type 

•  

Nota: a ciascun oggetto creato viene dato automaticamente un nome dall'applicazione. Quando l'oggetto 

viene selezionato, il suo nome compare nella vista Oggetti e nella barra degli strumenti Oggetto.  

Si può creare un oggetto usando una delle seguenti opzioni: 

• Creazione in modalità diretta: 

1. Fare clic direttamente sull'oggetto che si desidera inserire nel proprio documento. 

2. Fare clic sulla posizione in cui si desidera posizionare l'oggetto. 

       - OPPURE - 
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• Creazione in modalità guidata: 

1. Fare clic sul pulsante del menu del proprio oggetto. Apparirà un sottomenu con l'elenco delle 

azioni a cui è possibile assegnarlo (Oggetto fisso, Procedura guidata, Nuova fonte dati, Usa 
una fonte dati esistente). 

2. Selezionare l'azione appropriata. 

3. Fare clic sulla posizione in cui si desidera porre l'oggetto. 

Modifica di un oggetto 

Si può modificare un oggetto usando: 

• I pulsanti sulla barra degli strumenti, barra degli strumenti di formattazione, barra degli strumenti 

di allineamento, ecc. 

• Facendo doppio clic sull'oggetto. 

• Facendo clic col tasto destro del mouse sull'oggetto e selezionando Proprietà. 

• Nella vista Oggetti, facendo clic col tasto destro del mouse sull'oggetto e selezionando Proprietà. 

 

Creazione di un oggetto di testo 

Un oggetto di tipo testo può essere costituito da un carattere, una parola o un intero paragrafo. 

È possibile definire lo stile del carattere e il formato del paragrafo utilizzando la barra degli strumenti di 

formattazione del testo oppure la finestra di dialogo Testo. 

Per creare un oggetto di testo: 

1. Dalla barra degli strumenti Creazione, fare clic sullo strumento Crea testo . 
- oppure - 

Scegliere Oggetto > Testo. 

2. Fare clic all'interno dello spazio di lavoro oppure sul testo da modificare. 

- oppure - 

Selezionare e trascinare un riquadro nello spazio di lavoro. 

3. Immettere il testo. È possibile definire lo stile del testo utilizzando la finestra di dialogo Testo. 
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Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento.  

Per aprire la finestra di dialogo Testo: 

Scegliere Oggetto >Testo. 

- oppure - 

Premere il tasto F7. 

 

Creazione di un oggetto codice a barre 

Il software offre un'ampia gamma di simboli adatti alle esigenze del settore, nonché la possibilità di creare 

codici a barre a 2D. 

La selezione dei simboli, la definizione dei rispettivi attributi e l'immissione del messaggio da codificare 

avvengono tramite la finestra di dialogo Barcode. 

Per creare un oggetto codice a barre: 

1. Nella barra degli strumenti Creazione, fare clic sullo strumento Crea codice a barre . 

- oppure - 

Scegliere Oggetto > Codice a barre 

2. Fare clic all'interno dello spazio di lavoro. 

Si apre la finestra di dialogo Codice a barre. 

3. Dalla scheda Codice, selezionare il codice a barre desiderato. È possibile scegliere fra 

Stampante e Grafica. 

4. Fare clic su Stampante per visualizzare l'elenco dei codici a barre disponibili nella stampante. 

- oppure - 
fare clic su Grafica per visualizzare l'elenco dei codici a barre generati dal software. 

5. Se necessario, specificare le caratteristiche del codice a barre (altezza, larghezza barra stretta, 

rapporto, carattere di controllo). 

6. Immettere i dati da codificare nella finestra Dati. 
7. Fare clic su OK. 
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Nota : Alcune stampanti non dispongono di codici a barre. Ciononostante è possibile stampare codici a 

barre tramite l'opzione Grafica. In questo modo però il funzionamento della stampante è molto rallentato 

in quanto i codici a barre vengono inviati alla stampante sotto forma di immagini grafiche. 

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 

 

Tracciare una linea 

Creazione di un oggetto forma Esempio: tracciare una linea 

Il software viene fornito con una gamma di strumenti che consentono all'utente di creare etichette perfette. 

È possibile disegnare una linea, un cerchio, un rettangolo e così via utilizzando il processo descritto in 

seguito. 

Per tracciare una linea: 

1. Fare clic sullo strumento Disegna linea  . 

- oppure - 

Scegliere Oggetto > Disegno >Linea. 

2. Fare clic all'interno dello spazio di lavoro. 

3. Muovere il mouse tenendo premuto il pulsante sinistro. 

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 
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Disegnare un cerchio o un'ellisse 

1. Fate clic sullo strumento Disegna cerchio o ellisse . 
 

- o - 

 

Scegliete Oggetto > Disegno >Cerchio. 

2. Fate clic all'interno dello spazio di lavoro. 

3. Tenendo premuto il pulsate sinistro del mouse, spostate il mouse in orizzontale fino a ottenere la 

forma desiderata. 

Suggerimento 

• Per ottenere un cerchio, tenete premuto il tasto MAIUSC mentre trascinate il cursore. 

• Per disegnare delle ellissi partendo dal centro, tenete premuto CTRL mentre trascinate il cursore. 

• Per disegnare un cerchio simmetrico rispetto al centro, tenete premuto CTRL + MAIUSC mentre 

trascinate il cursore. 

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 

Esempio: Creazione di una custodia per CD: disegno di un cerchio 

1. Fare clic sullo strumento di disegno cerchio o ellisse. 

2. Fare clic all'interno dello spazio di lavoro. 

3. Tenendo premuto il pulsante sinistro del mouse e contemporaneamente il tasto MAIUSC, 

muovere il mouse orizzontalmente per creare la forma desiderata. 

4. Selezionare il cerchio e scegliere Proprietà dal menu di scelta rapida. 

5. Fare clic sulla scheda Posizione e immettere i seguenti valori:  
  Larghezza e Altezza: 20. 

6. Fare clic su OK. 

7. Selezionare Oggetto > Allineamento > Orizzontale al centro dell' etichetta per allineare il 

cerchio al centro della custodia. 

8. Selezionare il cerchio e fare clic sul pulsante Blocca. 
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Importazione di un'immagine 

Il software consente di inserire immagini e loghi aziendali per perfezionare le etichette. 

È possibile importare diversi formati: bmp, dib, dxf, emf, fmf, eps, fpx, img, gif, jpg, pcd, pcx, dcx, png, rle, 

tga, tif, wmf e wpg. 

1. Dalla barra degli strumenti di Creazione, fare clic sullo strumento Importa immagine  . 

- oppure - 

Scegliere  Oggetto > Immagine. 

2. Fare clic all'interno dello spazio di lavoro. 

Si apre la finestra di dialogo Selezione immagine. 

3. Nella scheda Trova file, selezionare l'immagine da importare. 

4. Selezionare il nome del file dell'immagine. 

5. Fare clic su OK. 

Nota : Per visualizzare un'anteprima dell'immagine, fare clic sul pulsante Anteprima. 

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 
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Composizione di un documento con oggetti variabili 

Informazioni sulle origini dati 

Un'origine dati contiene un elenco di variabili costituite da dati che hanno la stessa origine. Le origini dati 

possono essere suddivise in categorie e sottocategorie ad eccezione dell'origine Database. 

Quando si seleziona una origine dati, si indica dove risiedono i dati richiesti e di che tipo sono. I dati 

possono avere origine interna (formula, data, contatore) o esterna all'applicazione (database, immissione 

diretta, ActiveX). 

Le varie origini dati disponibili nella vista o nel menu Origini dati sono le seguenti: 

• L'origine dati Data: consente di inserire data e ora. 

• L'origine dati Contatore: consente di inserire un valore auto-incrementante. 

• L'origine dati Modulo: consente l'immissione di dati durante la stampa. 

• L'origine dati Formula: consente di creare formule all'interno del documento. 

• L'origine dati Database: consente di connettersi a un database. 

• L'origine dati Ricerca in tabella: consente di aggiungere il risultato delle ricerche effettuate nei 

database. 

• L'origine dati Libera: origine dati popolata da dati che non sono stati specificati al momento della 

creazione. Un'origine dati libera può essere utilizzata per creare origini dati intermedie. 

 

Creazione di una origine dati 

Le origini dati consentono di utilizzare dati esterni all'applicazione, ad esempio dati di calcolo, la data di 

sistema del computer e così via. I valori associati a tali variabili provengono da diverse origini dati. 

È possibile creare una origine dati da: 

La vista Origini dati 

1. Nella vista Origini dati, fate clic con il pulsante destro su una delle sorgenti di dati. 

2. Selezionate Aggiungi dal menu pop-up. 

Il menu Origini dati 
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1. Fare clic sul menu Origini dati. 
2. Selezionare una delle sorgenti dati. 

3. Fare clic su Aggiungi. 

La barra degli strumenti 

1. Fare clic su  nella barra degli strumenti. 

2. Selezionare la origini dati desiderata. 

3. Nel sottomenu, selezionare Aggiungi. 

Per ognuna di queste modalità di creazione: 

• L'origine dati creata viene visualizzata automaticamente nella origine dati selezionata. 

• L'applicazione associa all'origine dati un nome predefinito. 

Nota: Non è possibile utilizzare parentesi {} nel nome della variabile.  

Nota: Questa procedura si applica a tutte le origini dati, ad eccezione delle variabili create nell'origine dati 

Database. Per creare una variabile database, è necessario creare una query.  

• All'origine dati selezionata è possibile aggiungere categorie e sottocategorie, ad eccezione 

dell'origine dati Database. 

Nota: per creare le categorie e le sottocategorie, fare clic con il tasto destro del mouse sull'origine dati, 

quindi selezionare Aggiungi categoria 

 

 

L'origine dati Database 

Comando: Origine dati > Database > Crea/Modifica una query. 

L'origine dati Database contiene un elenco di variabili create in base alle necessità. Tali variabili sono 

popolate da dati provenienti da query o tabelle ASCII. 

Nota : Quando vengono create, le origini dati conservano i nomi dei campi che le popolano. Non è 

possibile rinominare le variabili database in quanto sono associate ai nomi dei campi del database. 
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Nota: Le variabili di database possono essere convertite in variabili di ricerca in tabella, se necessario. 

Comando: Origini dati > Database > Converti in ricerca in tabella... 

 

Creazione di una query 

Comando: Origine dati > Database > Crea/Modifica una query. 

• Selezionare l’origine dati dall’elenco Seleziona una origine dati. 

Nota:per una nuova origine dati fare clic sul pulsante Nuova origine dati. Questo consente di 

utilizzare la procedura guidata, scegliere tra un'origine dati ODBC/OLEDB o creare una 

connessione di origine web (Google Sheets, Microsoft Excel Online, OData Feed). 

Come impostazione predefinita, è attivata la modalità di creazione Standard. Tuttavia, per creare la 

query, è possibile utilizzare la modalità di creazione Avanzata SQL: 

Modalità di creazione standard 

2. Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca. 

L’opzione Inserisci il nome delle tabelle consente di visualizzare i nomi delle tabelle nell’elenco 

dei campi. 

3. Nell’elenco Elementi, selezionate gli elementi che desiderate visualizzare. 

4. Nell’elenco Seleziona campi, selezionate i campi delle tabelle selezionate. 

Suggerimento È consigliabile selezionare unicamente i campi utilizzati nell'etichetta, questo per ridurre 

gli scambi di dati con il database e quindi aumentare la velocità di elaborazione.  

5. Fate clic sul pulsante  per visualizzare il risultato. 

Modalità di creazione avanzata SQL 

2. Selezionate la modalità SQL. 

3. Immettete la query in formato SQL nel campo di modifica. 

-oppure- 

Fate clic su SQL Query Builder per accedere a Creazione query. Utilizzate l’intuitiva interfaccia 

per creare le query del database SQL. Potete creare nuove richieste graficamente oppure 

rappresentare graficamente richieste esistenti nelle vostre applicazioni. 



User Guide 

38 

 

4. Fare clic sul pulsante Risultato della query per visualizzare il risultato. 

Le origini dati create hanno i nomi dei campi del database. 

 

L'origine dati Ricerca in tabella 

Comando Origine dati > Ricerca in tabella > Aggiungi 

L'origine dati Ricerca in tabella contiene un elenco di origini dati che sono state create dall'utente. I valori 

dell'origine dati sono il risultato di ricerche condotte all'interno di database diversi da quelli associati al 

documento corrente. 

Tali ricerche vengono condotte in uno o più campi di database. I dati vengono estratti da uno dei campi 

individuati in un record (chiamato "campo risultato"). 

 

Definizione delle proprietà dell'origine dati Ricerca in tabella 

Comando: Origine dati > Ricerca in tabella > Proprietà... 
. 

1. Selezionare l’origine dati dall’elenco  Seleziona una origine dati. 

Nota: Per creare una nuova origine dati, fare clic sul pulsante Nuova... In questo modo sarà possibile 

utilizzare la procedura guidata oppure scegliere tra una origine dati ODBC o OLEDB. 
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2. Come impostazione predefinita, è attivata la modalità di creazione standard. Per effettuare una 

ricerca in tabella, è possibile anche utilizzare la modalità di creazione Avanzata: SQL 

Modalità di creazione standard 

3. Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca. 

4. Nell’elenco Seleziona il campo risultato, selezionate il campo il cui valore dovrà essere 

trasferito nella vostra variabile. 

5. Fare clic su   per aggiungere una riga. 

6. Selezionare il campo nella tabella esterna in cui volete eseguire la ricerca. 

7. Selezionare la variabile del documento corrente contenente il valore della ricerca. 

8. Fare clic sul pulsante Prove per visualizzare il risultato. 

Modalità di creazione avanzata SQL 

3. Fare clic sulla modalità di creazione del formato SQL. 

4. Inserire la query in formato SQL. 

-oppure- 

Fare clic su SQL Query Builder per accedere a Creazione query. In questo modo potrete 

avvalervi di un’intuitiva interfaccia per creare le query del database SQL. Potete creare nuove 

richieste graficamente oppure rappresentare graficamente richieste esistenti nelle vostre 

applicazioni. 

5. Fare clic sul pulsante Risultato della query per visualizzare il risultato nella finestra di dialogo 

Query. 

  

L'origine dati Data 

Comando Origine dati > Data > Aggiungi 

L'origine dati Data contiene un elenco di origini dati che sono state create. Tali origini dati vengono 

popolate dalla data di sistema del computer o dalla stampante. Questa origine dati consente di 

visualizzare la data e l'orario in un formato definito precedentemente. I valori vengono popolati 

automaticamente all'avvio di ogni sessione di stampa. 

È possibile inserire la data e/o l'ora corrente in un documento. È inoltre possibile aggiungere un valore 

fisso alla data o all'ora corrente. 
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Definizione delle proprietà dell'origine dati Data 

Comando: Origine dati > Data > Proprietà... 

1. Nella scheda Data, selezionare il formato desiderato per la data e l'ora. 

2. Il formato della data viene visualizzato nell'area Anteprima. 

3. Fare clic su OK. 

Esempio: Inserimento di una data 

1. Aprire una etichetta. 

2. Aggiungere una origine dati Data e denominarla datefab. 

3. Comporre la data nella finestra di dialogo Data. È necessario che il formato sia gg/mm/aa. Per 
aggiungere dei separatori, immettere il carattere "/" nella casella di testo nella parte in basso a 
sinistra della finestra di dialogo, quindi fare clic su Aggiunti. 

4. Fare clic su OK. 

5. Selezionare la data (datefab) e trascinarla nello spazio di lavoro.Scegliere Testo nel menu di 
scelta rapida. 

 

L'origine dati Contatore 

Comando Origine dati > Contatore > Aggiungi 

L'origine dati Contatore contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati 

vengono popolate da dati calcolati dal computer o dalla stampante. 

Il contenuto cambia con l'avanzare della stampa, in base a un valore iniziale e a un valore incrementale. 

 

Definizione delle proprietà dell'origine dati Contatore 

Comando: Origine dati > Contatore > Proprietà  

1. Selezionare il tipo di contatore. 

Se si desidera utilizzare un tipo di contatore diverso da quelli visualizzati nell'elenco, scegliere 

l'opzione Personalizzato e immettere una sequenza personalizzata. 

2. Immettere un valore nella casella Incremento. Per impostazione predefinita, l'incremento è 

uguale a +1. 
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3. Immettere un valore iniziale nella casella Valore iniziale. Per impostazione predefinita, tale valore 

è uguale a 0. 

4. Fare clic su OK. 

  

Beispiel: Erstellen des Zählers   

1. Öffnen Sie ein Label. 

2. Erstellen Sie einen Zähler mit dem Namen namcd.  

3. Wählen Sie diesen Zähler aus, und wählen Sie anschließend im Kontextmenü die Option 

Eigenschaften.   

4. Wählen Sie Dezimal als Zählerart.   

5. Geben Sie in das Feld Zählschritt den Wert ''1'' ein.   

6. Geben Sie in das Feld Aktuelle Wert den Wert ''1'' ein.   

7. Klicken Sie auf OK.   

8. Wählen Sie den Zähler aus, ziehen Sie ihn in den Arbeitsplatz, und legen Sie ihn dort ab. 

Wählen Sie im Kontextmenü die Option Texte.   

9. Klicken Sie mit der rechten Maustaste darauf, und wählen Sie im Kontextmenü die Option 

Eigenschaften.   

10. Wählen Sie die folgenden Texteigenschaften aus:      

• Schriftart: Arial,      

• Breite: 3.20 mm. 

  

L'origine dati Formula 

Comando Origine dati > Formula > Aggiungi 

L'origine dati Formula contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati 

vengono popolate da combinazioni di operatori, costanti, variabili, variabili di controllo, formule e funzioni. I 

dati possono essere numerici o alfanumerici. 

Per effettuare un calcolo all'interno di un documento, è necessario creare una origine dati Formula. 

Per questa origine dati esiste una finestra di dialogo specifica che consente di definire le funzioni 

necessarie alla formula data. 
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Definizione delle proprietà dell'origine dati Formula 

Comando: Origine dati > Formula > Proprietà... 

1. Immettere la formula direttamente nella casella editing. 

-o- 

Selezionate con il mouse gli elementi desiderati quindi fate clic su Inserisci. 

2. Fare clic su OK. 

Suggerimento: È possibile inserire un elemento selezionandolo con un doppio clic. 

Nota: Se il nome di una variabile utilizzata nella formula contiene uno dei seguenti caratteri &+-

*/<>=^%,!\", deve essere racchiusa tra parentesi {}. 

Note : Anteprima dinamica che rappresenta il risultato del calcolo della formula corrente, compresa la 

formattazione definita nella pagina Output. In caso di errore, l'anteprima viene visualizzata in rosso. Se il 

valore ottenuto è troncato, è necessario modificare la lunghezza massima specificata nella scheda 

Output. 

  

Esempio: Creazione di una formula semplice 

 Visualizzazione del prezzo di un prodotto 

 

L'etichetta di produzione deve indicare il prezzo del prodotto come funzione del peso e del prezzo al 

chilogrammo. 

1.  Aprire una etichetta con due variabili: WEIGHT e PRICEPERKG. 

2. Per la variabile WEIGHT: immettere 788 (assumendo che il peso del prodotto sia 788 g) come 
valore Local e immettere "Immettere il peso in g" nella casella Prefix, quindi fare clic su OK. 

3. Per la variabile PRICEPERKG: immettere 15,70 (il peso al kg è 15,70 euro) come valore Local 
della variabile. 

4. Iimmettere "Immettere il prezzo al kg" nella casella Prefix, quindi fare clic su OK. 

5. Aggiungere una formula e denominarla Prezzo. 

6. Immettere la formula WEIGHT*PRICEPERKG/1000, quindi fare clic su OK. 

7. Salvare il documento. 
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Esempio: Aggiunta di una variabile della formula "Avviso" per la visualizzazione di un messaggio 
di avviso. 

Nella sequenza seguente, verrà creata una formula nell'etichetta PRODUCT_WS3 perché venga 

visualizzato un messaggio di avviso che segnali all'utente che il valore della variabile condivisa 

Total_Weight supera 1.000 kg. 

Se il valore del peso supera i 1.000 kg, viene visualizzato il messaggio "Attenzione! Errore! Il peso totale 

supera il massimo consentito!" 

1. Aprire l'etichetta 

2. Creare una formula e denominarla "Avviso". 

3. Nella casella di dialogo Formula, immettere la seguente espressione: if(Total_Weight>1000, 
"Attenzione\n!Errore!\n Il peso totale supera il massimo consentito!", ""). 

4. Nella scheda Output, immettere 50 in Maximum length e fare clic su OK. 

5. Posizionare la variabile come testo all'interno dell'etichetta. 

6. Nella casella di dialogo Testo, selezionare Scalable come font e impostare il valore di Height a 
12,70 mm. 

7. Nella scheda Paragrafo, selezionare l'opzione A capo automatico e quindi Centra 
(allineamento) 

  

L'origine dati Modulo 

Comando Origine dati > Modulo > Aggiungi 

L'origine dati Modulo contiene un elenco di variabili che sono state create dall'utente. Tali variabili 

vengono popolate immettendo dati direttamente dal Modulo digitando sulla tastiera. 

Per visualizzare il modulo 

Il Modulo consente di immettere i dati direttamente durante la progettazione o, più comunemente, prima 

della stampa. 

Per visualizzare il modulo 

1. Aprire l'etichetta contenente una variabile Modulo. 

2. Fare clic sul pulsante    nella barra degli strumenti. 
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Come impostazione predefinita, lo spazio di lavoro consente di visualizzare l'etichetta e il modulo 

separatamente. 

Per visualizzare l'etichetta e il modulo insieme: 

1. Selezionare l'etichetta relativa al modulo. 

2. Trascinare la scheda verso l'alto o verso il basso fino a quando il Modulo non viene rilasciato 

nella sua finestra. Se lo si desidera, è possibile ancorare la nuova finestra. 

 

-oppure- 

1. Selezionare Finestra > Nuovo gruppo schede verticale 

Entrambe le viste sono ora visibili. 

Tutte le modifiche apportate all'etichetta o al modulo aggiorneranno automaticamente i dati dell'altro. 

 

Personalizzare il Modulo 

È possibile personalizzare l’aspetto del proprio modulo modificando il colore, il font e altri elementi nella 

finestra di dialogo Impostazioni modulo. 

Per accedere alla finestra di dialogo Impostazioni modulo: 

• Scegliere Vista > Impostazioni modulo. 

- oppure - 

• Selezionare il modulo con il mouse, fare clic con il tasto destro del mouse e selezionare 

Impostazioni modulo. 

- oppure - 

• Fare doppio clic sullo sfondo della finestra rappresentata nella vista Modulo (solo in modalità 

Modulo automatico) . 
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Creare un Modulo personalizzato con il Form Editor 

Aprire la finestra di dialogo Impostazioni modulo come indicato sopra. 

Impostare l’opzione modalità Modulo su Personalizzato e fare clic su OK. 

Accedere al Form Editor: 

1. scegliere Vista > Modulo > Modifica modulo... 
 

-oppure- 

 

scegliere Barra degli strumenti Vista > Modulo > Modifica modulo... 
 

-oppure- 

 

richiamare il menu del contesto Modulo > Modifica modulo... 

2. Scegliere la Modalità di creazione necessaria nella finestra di dialogo Procedura guidata per la 
creazione di un Modulo personalizzato: 

• Converti da Modulo automatico 
Consente di convertire facilmente i comandi dal Modulo automatico. 

• Configura i comandi manualmente 
Consente di assegnare origini dati ai comandi del Modulo manualmente. 

• Modulo vuoto 
Si aprirà lo strumento Form Editor con un Modulo vuoto pronto per essere personalizzato. 

Nota: qualora un’etichetta non contenga variabili, nella finestra di dialogo Procedura guidata per 
la creazione di un Modulo personalizzato è disponibile solo la modalità di creazione “Modulo 
vuoto”.  
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Nota: La Procedura guidata per la creazione di un Modulo personalizzato viene visualizzata 

quando il Form Editor viene aperto per la prima volta o reimpostato. In caso contrario, Form Editor 

viene visualizzato senza la procedura guidata.  

3. Selezionare un comando dalla barra degli strumenti sulla sinistra, quindi fare clic sul Modulo dove 

si desidera posizionare il comando. 

 

Il comando appare nel Modulo e le sue proprietà vengono visualizzate nella barra degli strumenti 

sulla destra. 

 

È possibile utilizzare il mouse per modificare la posizione e la dimensione del comando. 

 

È possibile modificare le proprietà del comando nella barra degli strumenti. 

 La tabella sottostante elenca i comandi disponibili e le loro principali funzionalità. 

Icona Controllo Funzionalità 

 

Inserimento testo Inserire un valore secondo determinati criteri. 

 

Selezione data Selezionare una data usando un calendario. 

 

Su/Giù numerico Selezionare un valore numerico usando le frecce in su/giù. 

 

Casella di controllo 
Selezionare uno dei due valori selezionando/deselezionando una 

casella. 

 

Elenco pulsanti radio 
Selezionare uno dei diversi valori selezionando il pulsante 

corrispondente. 

 

Casella degli elenchi Selezionare uno dei diversi valori selezionando la voce corrispondente. 

 

Selezione record Selezionare un record da un database. 

 

Selezione ora Selezionare un’ora secondo un formato definito. 

 

Cursore Selezionare un valore numerico da un intervallo definito. 

 

Acquisizione 

immagine 
Selezionare un file immagine. 

 

Etichetta Visualizza del testo fisso o il valore di un’origine dati. 

 

Linea Visualizza una linea fissa. 
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Immagine Visualizza un’immagine fissa o un’immagine definita in un’origine dati. 

 

Casella Raggruppa Raggruppare i comandi con un bordo e un’intestazione facoltativi. 

 

Anteprima etichetta  Visualizza l’anteprima dell’etichetta corrente. 

  

Esempio di Moduli personalizzati 

Troverai esempi di design di etichette che utilizzano la funzione Modulo personalizzato nella cartella degli 

esempi di etichetta. 

  

Modify the order in which data is entered into the form 

Potete modificare l'ordine in cui i dati vengono immessi nel modulo visualizzato. 

Procedete come segue: 

1. Selezionate il modulo utilizzando il mouse. 

2. Fate clic con il pulsante destro. 

3. Selezionate Avvia pianificazione. Compare la numerazione predefinita. 

4. Fate clic sul numero del campo che volete che compaia per primo nel modulo.  Tale campo 

diventa verde quando convalidato. 

5. Ripetete il passaggio 4 per continuare a ordinare i campi. 

6. Per confermare la selezione, fate clic sul pulsante destro e selezionate Convalida ordine dati. 

L'ordine dei campi verrà automaticamente convalidato alla convalida del primo campo.  Quindi la 

numerazione scompare dal modulo 

Nota: potete annullare qualsiasi modifica. Fate clic con il pulsante destro sul modulo e selezionate 

Abbandona... 

 

Definizione delle proprietà dell'origine dati Modulo 
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Comando: Origine dati > Modulo > Proprietà... 

• Fare clic sulla scheda Modulo. 

• Immettere il messaggio che si desidera venga visualizzato nel modulo. 

• Se lo si desidera, è possibile definire un formato di immissione e una lunghezza minima. 

• È possibile creare valori che verranno proposti nel modulo selezionando <Locale> dalla Elenco 

valori. In seguito fare clic su per accedere alla finestra di dialogo Elenco valori. 

• Nella scheda Output, è possibile definire un formato di output, una lunghezza massima, un 

suffisso e un prefisso. 

• Fare clic su  OK. 

Nota : Se viene definito un valore locale vuoto e si seleziona la casella Ripristina dopo la stampa, il 

valore della variabile verrà impostato su vuoto dopo ogni lavoro di stampa. 

  

L'origine dati Libera 

Comando Origine dati > Libera > Aggiungi 

L'origine dati Libera contiene un elenco di origini dati che sono state create dall'utente. Queste origini dati 

sono popolate da dati che non sono stati specificati al momento della creazione. Un'origine dati Libera 

può essere utilizzata per creare origini dati intermedie. 

Definizione delle proprietà dell'origine dati Libera 

Definite le proprietà delle origine dati dalla vista Origini dati. 

1. Nella scheda Input,selezionare una delle seguenti opzioni:Locale o Condivisa o A partire da un 

file . 

Se è stata scelta l'opzione Local, immettere il valore della variabile nella casella. Questo sarà il 

valore iniziale della variabile, quello che verrà stampato per primo. 

- oppure - 

Se è stata scelta l'opzione Condivisa, immettere il valore della variabile nella casella. Fare clic su 

OK. 
- oppure - 

Se è stata scelta l'opzione A partire da un file, selezionare il file richiesto. 
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2. Nella scheda Output, è possibile definire un formato di output, una lunghezza massima, un 

suffisso e un prefisso. 

3. Fare clic su OK. 

Esempio: Creazione di una variabile libera 

 

1. Aprire una etichetta. 

2. Creare una origine dati Libera e denominarla ''ref''. 

3. Inserire l'origine dati nell'etichetta in formato testo. 

4. Per evitare che l'origine dati venga visualizzata nella stampa, selezionarla e fare clic su  nella barra 

degli strumenti Oggeto. 

Creazione di oggetti variabili 

Un oggetto variabile è un testo, un codice a barre o un oggetto di tipo immagine costituito da elementi i cui 

valori non sono stati definiti al momento della creazione. È possibile associare diversi oggetti a una 

singola variabile. 

Il valore di tali elementi viene derivato da diverse origini dati al momento della stampa: 

• Immissione diretta dalla tastiera nel Modulo (origine dati Modulo). 

• Importazione da file o database esterno (origine dati Ricerca in tabella o Database ) 

• Calcolo del campo da computer (origini dati Formula, Contatore e Data) 

Nota :Nella vista Origini dati, una freccia rossa   indica la variabile associata all'oggetto selezionato.. 

 

Creazione di un oggetto variabile collegato a una origine dati esistente 

È possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo, 

disegni ecc.) nel documento utilizzando: 

• La barra degli strumenti di Creazione, 

-oppure- 

• Il menu Oggetto. 
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Seguendo le indicazioni fornite, è possibile creare un oggetto utilizzando una delle seguenti opzioni: 

• Creazione modalità diretta: 

1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento. 

2. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic 

sull'oggetto per aprire la finestra di dialogo Proprietà. 

3. Fare clic sulla scheda Origini dati. 
4. Selezionare Variabili. 
5. Selezionare la variabile che si desidera assegnare all'oggetto. 

- oppure - 

• Creazione modalità guidata (secondo i requisiti di utilizzo): 

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni 

disponibili 

2. Per creare un oggetto variabile utilizzando una origine dati esistente, si può scegliere di: 

- Selezionare Utilizzo di una origine dati esistente seguito dalla variabile interessata. 

oppure 

- Selezionare Procedura guidata per essere guidati passo per passo nel processo di creazione 

dell'oggetto variabile. 

3. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

Nota: la creazione guidata è abilitata come impostazione predefinita. Per disabilitarla, selezionare 

Strumenti > Opzioni > Procedure guidate. 

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 

Nota:L'opzione di assegnazione degli oggetti Testo/Codice a barre è disabilitata per le variabili di 

database e di ricerca in tabella contenenti tipi di dati BLOB (ad esempio, immagini da un database), 

pertanto possono essere utilizzate soltanto come origine dati per oggetti Immagine.  

 

  



Composizione di un documento con oggetti variabili 

51 

Creazione di un oggetto variabile collegato a una nuova origine dati 

È possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo, 

disegni ecc.) nel documento utilizzando: 

• La barra degli strumenti di Creazione, 

-oppure- 

• Il menu Oggetto. 

Seguendo le indicazioni fornite, è possibile creare un oggetto utilizzando una delle seguenti opzioni: 

• Creazione modalità diretta: 

1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento. 

2. Fare clic sul punto in cui si desidera posizionare l'etichetta. 

La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic 

sull'oggetto per aprire la finestra di dialogo  Proprietà. 

3. Fare clic sulla scheda Origini dati. 
4. Selezionare Variabili. 
5. Selezionare la variabile che si desidera assegnare all'oggetto, fare clic con il pulsante destro del 

mouse e selezionare Aggiungere. 

-oppure- 
Fare clic sul pulsante Nuovo, quindi selezionate la variabile da aggiungere. 

 -OPPURE- 

• Creazione modalità guidata (secondo i requisiti di utilizzo): 

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni 

disponibili. 

2. Per creare un oggetto variabile utilizzando una nuova variabile, è possibile scegliere di: 

- Selezionare Nuova origine dati, 
oppure 

- Selezionare Procedura guidata: per essere guidati passo per passo nel processo di creazione 

dell'oggetto variabile. 

3. Fare clic sull'ubicazione in cui desiderate posizionare l'etichetta. 
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Nota: la creazione guidata è abilitata come impostazione predefinita. Per disabilitarla, selezionare 

Strumenti > Opzioni > Procedure guidate.  

Nota: è possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo 

di oggetto desiderato, selezionare l'azione desiderata e fare clic sulla posizione in cui si desidera 

posizionare l'oggetto nel documento. 

Nota:L'opzione di assegnazione degli oggetti Testo/Codice a barre è disabilitata per le variabili di 

database e di ricerca in tabella contenenti tipi di dati BLOB (ad esempio, immagini da un database), 

pertanto possono essere utilizzate soltanto come origine dati per oggetti Immagine.  
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Stampa 

Un potente motore di stampa 

Il software è uno strumento di creazione potente e semplice da usare e al contempo un motore di stampa 

utilizzabile con la più vasta gamma di stampanti possibile (termiche, a trasferimento termico, a getto 

d'inchiostro), mai disponibile finora sul mercato dell'identificazione automatica. 

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa 

etichetta, i comandi di stampa sono raggruppati in un unico punto, la finestra di dialogo Stampa. 

Inoltre, il software per l'etichettatura consente di installare e controllare le stampanti in qualsiasi punto 

della rete. 

In questa sezione verranno illustrate tutte le possibili configurazioni di rete e le relative procedure di 

installazione per l'ottimizzazione della stampa delle etichette. 

Stampa di una etichetta 

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa 

etichetta, le impostazioni di stampa vengono definite tutte nella la finestra di dialogo Stampa. 

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa. 

È anche possibile fare clic sul pulsante  o premere F6. 

2. Nella casella di testo Etichette, immettere il numero di etichette da stampare. 

3. Fare clic su OK. 

Esercitazione pratica 1 - Etichetta e serie di etichette 

Per iniziare, è necessario chiarire la distinzione fra Etichetta e serie di etichette. 

Nota: Se l'etichetta non include un contatore, la finestra di dialogo Stampa non visualizzerà il 

campo Copies of each label, ma solo il campo Labels, che in questo caso avrà la stessa funzione. 

Per chiarire la differenza fra Etichetta e serie di etichette, verrà presa in considerazione 

un'etichetta contenente due tipi di contatori e la finestra di dialogo Stampa verrà configurata in 

diversi modi. 
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• Aprire una etichetta . 

Creare diversi contatori: 

• Un contatore classico che conta tutte le etichette e si reimposta quando il 

conteggio raggiunge 10: 

• Tipo 

• Incremento +1 

• Valore minimo 0 

• Valore massimo 10 

• Un contatore ISO che consente la numerazione singola di ciascuna copia delle 

etichette. Anche questo contatore si reimposta quando raggiunge il valore 10: 

• Tipo 

• Incremento +1 

• Valore minimo 0 

Il primo contatore, chiamato NumLabel, identifica un'etichetta particolare mentre il contatore ISO 

conta il numero totale di etichette stampate. 

  

Etichette in serie 

In questo esempio verrà stampata una serie di 10 etichette: 

1. Specificare i seguenti valori nella finestra di dialogo Stampa: 

• Etichette : 10. 

In questo modo viene specificato che nella serie saranno presenti 10 diverse etichette. 

2. Fare clic su Stampa. 

Il risultato della stampa è quello atteso: sono state stampate 10 etichette e i due contatori visualizzano lo 

stesso valore. 

Copia delle etichette 

In questo esempio verrà stampata una serie di cinque etichette, questa volta però verranno realizzate due 

copie per ognuna. 
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1. Specificare i seguenti valori nella finestra di dialogo Stampa: 

• Etichette: 5 

• Copia delle etichette: 2. 

2. Fare clic su Stampa. 

Sono state stampate 10 etichette; tuttavia, il risultato è completamente diverso rispetto a quanto ottenuto 

nell'esempio precedente. 

Copia di una pagina 

Come abbiamo appena visto, è possibile stampare diverse copie della stessa etichetta. Nel prossimo 

esempio vedremo che è possibile anche stampare diverse copie della stessa pagina. Per far ciò, è 

necessario sapere con esattezza che cos'è una pagina per la stampante. 

La pagina è determinata dai parametri specificati durante la configurazione del driver della stampante. I 

risultati ottenuti possono essere completamente diversi a seconda che si utilizzi una stampante da ufficio 

o una stampante termica. Può essere difficile visualizzare una pagina su carta continua, utilizzata 

principalmente dalle stampanti termiche. 

Inoltre, in base alle dimensioni del supporto di stampa e dell'etichetta, le dimensioni della pagina possono 

corrispondere a quelle dell'etichetta, di conseguenza la copia della pagina può essere la stessa 

dell'etichetta. 

Il formato della pagina e la dimensione dell'etichetta vengono definiti nella finestra di dialogo Imposta 

pagina. 

1. Aprire  una etichetta. 

2. Selezionare File > Seleziona stampante. 

3. Selezionare una stampante per ufficio Windows. 

4. MVerificare che il formato della carta sia A4, quindi fare clic su OK. 

5. Selezionare File > Imposta pagina o fare clic su  . 

Verrà visualizzata la finestra di dialogo Imposta pagina. 

L'anteprima di stampa dà un'idea di come sarà la pagina stampata. 

6. Chiudere la finestra di dialogo. 

7. Fare clic su  . 
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8. Immettere i seguenti valori: 

• Etichette: 8 

• Copie per pagina: 2 

9. Fare clic su Stampa. 

Avvio di una unione di stampa 

L'opzione di unione è disponibile quando è stato aperto un database di tipo merge. Avvia la stampa delle 

etichette, con l'inclusione di tutti i record del database. 

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa. 

-oppure- 

Fare clic sul pulsante . 

2. Nella casella di testo Etichette, immettere il numero di etichette da stampare. 

3. Selezionare la scheda Database. Nel campo Record, selezionate Tutti i record. 

4. Fare clic su OK. 

Stampa con il modulo 

Quando il modulo ha l'aspetto desiderato, è possibile avviare la stampa. 

1. Selezionare File > Stampa oppure premere il tasto F6. 

2. Immettere ''2'' nel campo Etichette. 

3. Avviare la stampa. 

Il modulo viene visualizzato ed è necessario immettere i dati da stampare. 

4. Immettere ''Smith'' e ''51'',  ad esempio, quindi fare clic su OK. 

Una volta stampata la prima etichetta, il modulo viene visualizzato nuovamente. 
5. Immettere ''Mullang'' e ''52'', ad esempio, quindi fare clic su OK. 

Note: Il modulo viene visualizzato per ogni etichetta contenuta nella serie. Se si sceglie l'opzione Per ogni 

serie, il modulo verrà visualizzato una sola volta, all'avvio della stampa della serie. 
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In breve 

La finestra di dialogo Print 
contiene differenze... 

Quando l'etichetta include un contatore: l'opzione Etichette consente di 

specificare il numero di etichette in una serie; 

Copia delle etichette consente di determinare il numero di copie della stessa 

etichetta da stampare. 

Quando l'etichetta non include un contatore, questa opzione ha la stessa 

funzione del campo Etichette. 

Copia di una pagina È possibile copiare una pagina solo se l'etichetta non include un contatore ISO 

e se la pagina contiene più di un'etichetta. 

Unione di stampa Questa opzione stampa tutti i record in un database ed è disponibile solo se 

l'etichetta è associata a un database. 

Stampa con il Modulo Il Modulo consente all'operatore di immettere i dati dalla tastiera subito prima 

della stampa. 

Risoluzione dei problemi 

La seguente tabella elenca i problemi che si verificano più di frequente durante la stampa e offre alcune 

soluzioni per aiutare l'utente a risolverli. 

Problema Causa Soluzione 

Non viene stampato 

niente 

La stampante non è collegata. Collegare la stampante. 

  Per un collegamento parallelo: 

- La stampante non è configurata 

per un collegamento parallelo. 

Assicurarsi che l'impostazione sia stata configurata 

nel pannello di controllo della stampante (fare 

riferimento al manuale del produttore). 

  Per un collegamento seriale: le 

impostazioni della comunicazione 

seriale non sono corrette. 

Assicurarsi che le impostazioni di comunicazione tra il 

PC e la stampante siano le stesse (per le 

impostazioni di comunicazione seriale richieste dalla 

stampante, fare riferimento al manuale del 

produttore). 

  Il cavo seriale non è adatto. Assicurarsi che il cavo soddisfi i requisiti della 

stampante (fare riferimento al manuale del 

produttore). 
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  In entrambi i casi (collegamento 

seriale o parallelo): 

- Il cavo è connesso alla porta 

sbagliata. 

Verificare la connessione. 

  In entrambi i casi (collegamento 

seriale o parallelo): 

- Il cavo è connesso alla porta 

sbagliata. 

Verificare la connessione. 

      

Una pagina non 

viene stampata 

Per la stampa termica: il supporto 

di stampa è stato inserito nel modo 

sbagliato (la testina di stampa 

riscalda il lato sbagliato della carta. 

Reinserire il supporto nel modo corretto. 

  Per la stampa a trasferimento 

termico: il nastro non è stato 

inserito oppure è stato inserito nel 

modo sbagliato. 

Controllare il nastro e riposizionarlo se necessario 

(fare riferimento al manuale del produttore). 

  La modalità di stampa richiesta 

non è stata selezionata sulla 

stampante. 

Verificare che la modalità di stampa (termica o a 

trasferimento termico) sia stata selezionata 

correttamente sulla stampante (fare riferimento al 

manuale del produttore) oppure nella finestra di 

dialogo Configura stampa. 

Non è stato 

stampato un oggetto 

grafico (immagine, 

font di Windows, 

codice a barre 

ecc...). 

La memoria della stampante è 

esaurita. 

Verificare l'opzione Cancella memoria a stampa la 
prossima volta; se il problema persiste, verificare la 

quantità di memoria dedicata alle immagini (nella 

scheda Immagini del driver della stampante). 

  La stampante non ha abbastanza 

memoria. 

Aumentare la quantità di memoria della stampante 

aggiungendo una scheda di memoria extra oppure 

aumentando la RAM (fare riferimento al manuale del 

produttore oppure chiedere al rivenditore dal quale si 

è acquistata la stampante). 

  Alcune stampanti non riconoscono 

un oggetto se questo si 

Correggere la posizione dell'oggetto sull'etichetta. 
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sovrappone all'area stampabile, 

anche solo di pochi millimetri. 

La stampante 

termica è inceppata 

Il supporto di stampa non è lo 

stesso di quello definito nella 

finestra di dialogo Imposta pagina 

(carta continua o con spazi). 

Verificare che durante l'impostazione della pagina sia 

stato selezionato il supporto di stampa corretto: 

Continuous, With gap. 
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